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Flash  
Bölüm 1 
 
Flash’a Genel Bakış  
  
 

Bu Bölümde Neler Var? 
 

• Flash’ı çalıştırmak 

• Flash’ta dosya açmak 

• Sahne’nin temelleri 

• Zaman çizelgesi’ne katman eklemek 

• Zaman çizelgesi’nde anahtar kare oluşturmak 

• Özellikler denetçisinde ilgili ayarları yapmak 

• Panelleri açmak ve panellerle çalışmak 

• Araçlar panelindeki araçları seçmek ve kullanmak 

• Flash yardım bölümünde konu aramak 
 
 
 

Flash’ı Başlatmak Ve Dosya Açmak 

 
Öncelikle Flash’ı başlatalım. Bu yapmak için Başlat > Tüm Programlar > Adobe Flash CS3 
komutunu seçin. 
 
Flash’ı ilk kez çalıştırdığınızda standart dosya şablonları, eğitimler ve diğer kaynaklarla 
bağlantı sağlayan bir açılış ‘‘Merhaba Ekranı’’ karşılaşacaksınız. 
 
Bu ekranda daha önceden hazırlanmış olan Flash dökümanlarını(FLA) açabilir, yeni Flash 
dökümanları oluştrabilir, mevcut Flash şablonlarından yeni dökümanlar oluşturabilir ve 
Adobe web sitesine giderek  yeni ders içeriklerini  görebilirsiniz. 
 
Çalışma Alanını Tanıyalım 
 
 
Adobe Flash uygulamasının çalışma alanı, ekranın en üst kısmında bulunan komut 
menülerinin yanı sıra filmlerinizi düzenlemek ve bunlara yeni öğeler eklemek için
 kullanabileceğiniz birçok araç ve paneli de içerir. Animasyonunuz için 
gereken tüm nesneleri Flash’ta oluşturabilir veya Adobe Illustrator, Adobe Photoshop, 
Adobe After Effects ve diğer uyumlu uygulamalarda oluşturduğunuz öğeleri Flash’a 
aktarabilirsiniz. 
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Varsayılan durumda Flash ekranında menü çubuğu, Zaman Çizelgesi, Sahne,  Araçlar 
paneli, Araçlar denetçisi ve diğer birkaç panel görüntülenir. Flash’ta çalışırken panelleri 
açabilir, kapatabilir, sabitleyebilir, ayırabilir ve ekranda taşıyabilirsiniz. Varsayılançalışma 
alanına dönmek isterseniz, Sahne’nin hemen üzerinde yer alan düzenleme çubuğundaki 
Çalışma Alanı menüsünden Varsayılan’ı seçin. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Scene 
 

Flash’taki Scene, tıpkı gerçek bir sahne gibi, izleyenlerin oynatılan bir filmi  görmesini 

sağlayan alandır. Sahne, ekranda görüntülenen metinleri, resimleri ve videoları içerir. 
 
 
Belirli öğeleri Sahne’nin içine veya dışına taşıyarak bu öğelerin Flash filmlerinizin 
oynatılacağı Web tarayıcısının penceresinin veya Flash Player’da bulunan dikdörtgen 
şeklindeki alanın içine girecek ya da dışına çıkacak şekilde hareket etmesini 
sağlayabilirsiniz. Öğeleri Sahne’nin üzerine yerleştirmek için  ızgaradan, kılavuzlardan ve 
cetvellerden faydalanabilirsiniz. Sahne’nin 

etrafındaki çalışma alanını görmek için Yakınlaştırma aracını ( 

görüntüyü uzaklaştırabilir. 

 ) kullanarak 

Sahne’yi, tümüyle uygulama penceresine sığacak şekilde ölçeklemek  isterseniz   
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View > Zoom > Show Sığdır komutunu seçin. Sahne’nin hemen  üzerinde bulunan açılır 
menüdeki görünüm seçeneklerini de kullanabilirsiniz. 
 
Time Line 
 
Zaman, filmlerde olduğu gibi Flash belgelerinde de kareler yardımıyla ölçülür. Film 
oynatılırken oynatım kafası Zaman çizelgesi’daki kareler boyunca ilerler. Farklı karelerde 
Stage’deki içeriği değiştirebilirsiniz. Bir karenin içeriğini Stage’de görüntülemek için 
oynatım kafasını Zaman Çizelgesi’nde bu karenin üzerine getirin. Zaman Çizelgesi’nin en 
alt kısmında, seçilen karenin numarası,  geçerli kare hızı (saniyede oynatılan kare sayısı) ve 
filmde o ana kadar geçen süre belirtilmektedir. 
 

 
 
Zaman Çizelgesi’nde ayrıca, çalışmanızı organize etmenize yardımcı olacak katmanlara da 
yer verilmiştir. Katmanları , üst üste yığılmış çeşitli film şeritleri olarak düşünebilirsiniz. Her 
katman, Sahne’de görüntülenen farklı bir resmi  içerir. Diğer katmanlardaki nesneleri 
etkilemeden bir katmanda yeni nesneler  çizebilir veya mevcut nesneleri 
düzenleyebilirsiniz. Katmanlar, Zaman Çizelgesi’nde göründükleri sırayla üst üste yığılır, 
dolayısıyla Zaman Çizelgesi’nde en alt katmanda yer alan nesneler, Sahne’deki yığının en 
altında yer alırlar. Katmanları gizleyebilir, görüntüleyebilir, kilitleyebilir ve kilitlenmiş 
katmanların kilidini açabilirsiniz. Her katmanın sahip olduğu kareler benzersizdir, fakat 
kareleri sürükleyerek aynı katmanda farklı bir konuma  taşıyabilir veya başka bir katmana 
kopyalayabilir ya da taşıyabilirsiniz. 
 
Layer  Eklemek Ve Değişiklikler Yapmak 
Yeni bir Flash belgesi sadece tek bir katman içerir, fakat bu belgeye istediğiniz kadar 
katman eklemeniz mümkündür. Her katmanı içeriğini belirtecek şekilde adlandırmak iyi 
bir yaklaşımdır, böylece daha sonra ihtiyaç duyduğunuz bir katmanı kolayca bulabilirsiniz. 

 
1. Time Line daki ilk katmanı seçin 
2. Insert  > Timeline > Layer komutunu seçin. Bu işlem sonucunda seçmiş olduğunuz 
katman üzerine yeni bir katman oluşacaktır. 
 
 

 
 
3. Adlandırmak üzere yeni katmana çift tıklayın ve ilgili alana ‘‘yeni katmanım’’ yazın. 
Katman Adı kutusunun dışına tıklayarak yeni ismin 

atanmasını sağlayın. Katmanların isimlendirmesin de türkçe karakterler, boşluk ve 
rakamları dilediğiniz gibi kullanabilirsiniz. 

4. Katmanların üstünde yer alan kilit simgesine tıklayarak bütün  katmanları kilitleyin. 
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Bir katmanı kilitlediğinizde, bu katmanın üzerinde yanlışlıkla değişiklik 
yapılmasını engellemiş olursunuz. 
5. Bir katmanı diğerlerinden bağımsız tek başına kitlemek 
istiyorsanız o katmanın sağ yanına doğru bulunan kilit işaretini tıklayrak 
bu işlemi yapabilirsiniz. 
 

 
 

Key Frame (Ana Kare) Oluşturmak 
 
Her bir ana kare, Sahne’deki içerikte meydana gelen bir değişikliği gösterir. Katmanlara 
yeni bir anahtar kare eklemek için Ekle > Zaman Çizelgesi > Ana Kare komutunu seçin. 
 
Library(Kitaplık) Paneliyle Çalışmak 
 
Kitaplık panelinde, Flash’ta oluşturulan sembollerin yanı sıra bitmap’ler, grafikler, ses 
dosyaları ve video klipler de dahil olmak üzere içe aktarılan çeşitli  dosyaları saklar ve 
organize edersiniz. 

 
 
 
 

 
Kütüphane  paneli, kitaplık öğelerini klasörler halinde düzenlemenizi, bir belgede belirli 
bir öğenin kaç kez kullanıldığını görmenizi ve öğeleri tiplerine göre sınıflandırmanızı 
sağlar. Flash’a öğe aktarırken bu öğeleri Sahne’ye veya  kitaplığa aktarabilirsiniz. Bununla 
birlikte, doğrudan Sahne’ye aktardığınız her öğe, oluşturduğunuz her sembol gibi 
kitaplığa da eklenir. Böylece, tekrar  Sahne’ye eklemek, düzenlemek veya özelliklerini 
görmek için öğelere kolayca erişebilirsiniz. 
 
Kitaplık panelini görüntülemek için Window > Library  komutunu seçin veya Ctrl+L  
Windows] ya da Command+L [Mac OS] tuşlarına basın. 
 
Kitaplık panelinde bir öğe seçtiğinizde, bu öğenin minik resim önizlemesi açılır. Eğer 
seçtiğiniz öğe bir ses dosyası ise veya animasyon içeriyorsa,  Control penceresindeki 
Oynat(Play) düğmesine tıklayarak dosyayı dinleyebilir veya izleyebilirsiniz. 

 
 
Eğer Özellikler denetçisi açık değilse Pencere > Özellikler > Özellikler   komutunu  seçin  
veya  Ctrl+F3    [Windows]  ya  da  Command+F3  [Mac  OS]  tuşlarına basın. 
 
Döküman Ayarları 
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Bir flash projesini başlamadan önce yapılabilecek en mantıklı hareket bir  döküman ve 
sahne ayarlarının yapılmasıdır. Bu ayarları yaparken kullanacağız  değerleri bir projeye 
başlamadan aklınızda oluşturma çalışın. Daha sonra  döküman ayarlarının değiştirilmesi 
projenizin bazı kısımlarını yeniden  tasarlamanızı gerektirebilir. 

 
 
 
 
 
 
 
 
 
 
Filmin Sahne Boyutlarının Belirlenmesi 
 
İlk karar verilmesi gereken Flash filminizin boyutlarının belirlenmesidir. Dökümanın 
genişlik ve yükseklik ayarlarının yapılması için sahne üzerindeki boş bir alana tıklayın ve 
Özellikler denetleyicisinden Boyut yazısının yanındaki  düğme’ye tıklayın.
 Açılan pencerede filminizin sahne boyutlarını değiştirebilirsiniz. Varsayılan 
değerler 550x400’dür. Bu değerleri özel bir  sebebiniz yoksa değiştirmemizi tavsiye 
ederim. Bu ebadlardaki bir flash filmi en düşük çözünürlüklü bir ekranda bile web 
tarayıcının kaydırma çubuklarının  çıkmadan gösterilmesini sağlar. Flash projelerinde 
tasarımcılar mümkün  olduğunca kaydrıma çubuklarının çıkmasını engellemek isterler ve 
bu 
doğrultuda tasarımlarını yaparlar. 
 
 
Filmin Sahne Arkaplanının Belirlenmesi  
 
Flash filmleri ilk kez oluşturduklarında varsayılan olarak beyaz bir arka plan ile 
oluşturulurlar. Arka plan renginin değiştirilmesi sahne üzerinde boş bir alana  tıklayıp, 
Özellikler denetleyicisinden Arka Plan özelliğini değiştirebilirsiniz. 
 
Filmin Hızının Belirlenmesi  
 
 
Kare hızı bir flash filminin bir saniyede kaç kare göstereceğini belirler. Bu  değer varsılan 
olarak 12 kare/sndir. Bu değeri artırırsanız Flash filmleriniz daha hızlı oynarlar, düşürülmesi 
ise tam tersi etki yaratır. İnsan gözü bir saniyede en fazla 24 kare görebilir. Eğer özel bir 
amacınız yoksa bu değerin 12 kalması  faydalı olur. Kare hızının artırılması 
kullanıcının(ziyaretçinin) filmi oynatması sırasında daha fazla hafıza ve işlemci 
kullanmasını , kare hızının düşürülmesi ise kesik kesik animasyonların oluşmasını sağlar.   
 

Panellerle Çalışmak 
 

Flash’ta gerçekleştirdiğiniz hemen her işlemde panellerden faydalanırsınız. Paneller Flash 

çalışma alanının ayrılmaz bir parçasıdır.   
 
 
Flash’ta bir paneli açmak için Window menüsünden bu panelin adını seçin. Belirli birkaç 
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paneli açmak için bir alt menüyü kullanmanız gerekebilir (Window > Properties > 
Properties veya Window > Tolbars > History gibi). 
Varsayılan durumda Özellikler denetçisi, Filtreler paneli ve Parametreler paneli ekranın en 
alt kısmında bir arada, Zaman Çizelgesi en üstte ve Araçlar paneli  sol tarafta yer alır. Diğer 
panellerin çoğu ekranın sağ tarafında görüntülenir.  Bununla birlikte, panelleri sizin için 
uygun olan herhangi bir konuma taşımanız da mümkündür. 

 
• Bir paneli ekranın sağ tarafındaki konumundan ayırmak isterseniz paneli  
sekmesinden tutarak yeni konumuna doğru sürükleyin. 
• Bir paneli sabitlemek isterseniz, paneli sekmesinden tutup ekranın sağ tarafındaki
 panel bölmesine doğru sürükleyin. Buradapaneli sürükleyerek diğer
 panellerin üstüne, altına ya da arasına yerleştirebilirsiniz. 
• Bir paneli bir diğeriyle gruplamak isterseniz, söz konusu panelin sekmesini diğer 
panelin sekmesinin üzerine sürükleyin.   
• Bir panel grubunu taşımak isterseniz, grubu başlık çubuğundan tutup  

sürükleyin. 
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Tools Panelini Kullanmak 
 

Çalışma alanının en sol tarafında yer alan ince uzun Araçlar paneli, seçim araçları, 

çizim ve yazı araçları, boyama ve düzenleme araçları, gezinti araçları ve araç 

seçeneklerini içerir. Araçlar panelini, Seçim Aracı, Metin Aracı ve çizim araçları 

arasında geçiş yapmak için sık sık kullanacaksınız. Bir aracı seçtiğinizde, dolgu ve 

kontur ayarlarından ya da diğer 

ayarlardan çalışmanız için uygun olanları kullandığınızdan emin olmak için panelin 

en altındaki seçenekler alanını kontrol etmeyi unutmayın. 
 

Bir Aracı Seçmek Ve Kullanmak  
 

Bir aracı seçtiğinizde, Araçlar panelinin en altında yer alan seçenekler değişir. 

Örneğin, bir çizim aracını seçtiğinizde burada Nesne Çizimi modu ve Nesnelere 

Yapış seçenekleri görüntülenir. Yakınlaştırma Aracını  seçtiğinizde ise Büyüt ve 

Küçült seçenekleri görüntülenir.  

Gizlenmiş Durumdaki Bir Aracı Seçmek  
 

Araçlar panelinde, hepsi aynı anda görüntülenemeyecek kadar çok araç bulunur. 

Bazı araçlar Araçlar panelinde gruplar halinde düzenlenmiştir  ve  bir  grupta  

sadece  en  son  seçtiğiniz  araç  görüntülenir.  Eğer  araç düğmesinin sağ alt 

köşesinde küçük bir üçgen varsa, bu grupta başka araçlar da bulunmaktadır. Var 

olan diğer araçları görmek için görünenaracın simgesine tıklayarak farenin 

düğmesini basılı tutun ve açılan menüden istediğiniz aracı seçin. 
 

Yardımcı Tuşlar Ve Araçlar  
 

Çizerken Shift tuşunu basılı tuttuğunuzda mükemmel bir daire çizersiniz. Birçok 

aracı kulanırken belirli bir tuşu basılı tutarak bu araçların kul anım şeklinde 

değişiklik yapabilirsiniz. Örneğin Yakınlaştırma Aracını kullanırken Alt [Windows] 

veya Option [Mac OS] tuşunu basılı tuttuğunuzda araç Büyüt  modundan Küçült 

moduna geçer 
 
 

Flash’ta Uygulanan Adımları Geri Almak 

Flash’da bazen bir iki adım geriye gidip bazı şeylere baştan başlamanız gerekebilir. 
Flash’ta Geri Al komutunu ya da Geçmiş panelini kullanarak daha  önce gerçekleştirdiğiniz 
adımları geri alabilirsiniz.Flash’ta tek bir adımı geri almak isterseniz Düzenle > Geri Al 
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Hiçbirini Seçme  komutunu seçin ya da Control+Z [Windows] veya Command+Z [Mac OS] 
tuşlarına basın. Geri aldığınız bir adımı tekrar uygulamak isterseniz Düzenle > Tekrarla 
Hiçbirini Seçme komutunu seçin.Flash’ta birden fazla adımı geri almak için en kolay 
yöntem Geçmiş panelini kullanmaktır. Bu panelde,  çalışılan belgeyi açışınızdan itibaren 
gerçekleştirdiğiniz bütün adımların bir listesi görüntülenir. Bir belgeyi kapattığınızda bu 
belgenin geçmişi temizlenir. 
 
 
Geçmiş panelini açmak için Pencere > Diğer Paneller > Geçmiş komutunu seçin. 
 
 
Filmi Önizlemek 
 
 
Bir proje üzerinde çalışırken istenen efektlerin elde edildiğinden emin  olmanın en iyi yolu 
proje filmini sık sık önizlemektir. Bir animasyonun ya da  filmin izleyicilere nasıl  
görüneceğini hızlı bir şekilde kontrol etmek için Control > Rewind komutunu seçin. 
Filminizi önizlemek için Ctrl+Enter [Windows] veya Command+Return [Mac OS] tuşlarına 
da basabilirsiniz. 
 
 

Filmi Yayınlamak 
 
 
Başkalarıyla paylaşmaya hazır olduğunuzda, filminizi Flash’ı kullanarak yayınlayabilirsiniz. 
Flash, çoğu projede bir HTML dosyası, bir SWF dosyası ve bir JavaScript (.js) dosyası 
oluşturur. SWF dosyası, nihai Flash filminizdir. HTML dosyası SWF dosyasını içerir Java 
Script dosyası ise Web tarayıcılarının filminizle uyumlu bir şekilde çalışmasını sağlar. Bu 
üçdosyayı Web sunucunuzda aynı klasöre yüklemeniz gerekir. Filmlerinizi yükledikten 
sonra daima test edin.   

 
 

• File > Publish Ayarları komutunu seçin. 

• Formatlar sekmesine tıklayın. 

• Flash (.swf) ve HTML (.html) seçeneklerini işaretleyin. 

• Yayınla düğmesine tıklayın.Tamam düğmesine tıklayarak iletişim 

kutusunu kapatın. 

• Flash’ın oluşturduğu dosyaları görmek fla dosyanızın kayıtlı olduğu 

yada yayınlama ayarlarında belirtiğiniz klasöre gidiniz 
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Flash Yardım’ı Kullanmak 
 
 
Paneller, araçlar ve diğer uygulama özelliklerinin kullanımıyla ilgili ayrıntılı bilgi edinmek 
isterseniz Flash Yardım bölümünden faydalanabilirsiniz. Flash Yardım bölümünü açmak 
için Yardım > Flash Yardım komutunu seçin.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Flash Yardım, birkaç kitap halinde düzenlenmiştir. Using Flash (Flash’ı  Kullanmak) adlı 
kitap, işlemlerin uygulanmasıyla ilgili ipuçları, eğitimler ve Flash’ta kullanılan kavramlarla 
uygulamaların özelliklerine ait açıklamaları  içermektedir. Programming ActionScript , 
ActionScript Language and Components Reference ve Using ActionScript  
Components, Flash filmlerinizin işlevselliğini geliştirmenizi ve  filmlerinize etkileşim 
özellikleri eklemenizi sağlayan ActionScript ile ilgili referanslardır. 
 

İçindekiler Bölümüne Göz Atmak  
 
 
Eğer Flash’taki genel bir özellik grubuyla veya bir kavramla ilgili ayrıntılı bilgi edinmek 
istiyorsanız İçindekiler bölümüne göz atabilirsiniz. Burada, Flash CS3’teki yeni özellikler 
hakkında ayrıntılı bilgi edinmek için İçindekiler bölümünü kullanacaksınız. 

 

• Help > Flash Yardım komutunu seçin. 

• Using Flash kitabını genişleterek İçindekiler listesini görüntüleyin. 

• Getting Started > Whats New > New Features başlığına tıklayarak Flash CS3’teki 

yeni 

• özelliklere ait bağlantıları görüntüleyin. 
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Anahtar Sözcükleri Aratmak  
 
 
Eğer bir konunun İçindekiler bölümünün neresinde bulunduğundan emin  değilseniz  
ya  da  belirli  bir  kavram  ya  da terimle ilgili bütün konuları görmek  istiyorsanız, 
uygun anahtar sözcüğü aratın. Örneğin ‘‘History paneli’’ Yardım >  Flash Yardım 
komutunu seçin. Search alanına history yazın.Search düğmesine  tıklayın. History 
paneli hakkındaki bilgileri görüntülemek için ‘‘Using the History Panel’’başlığını seçin. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Sembol Oluşturmak ve 

Düzenlemek 

Bu Bölümde Neler Var? 
 

• Semboller 

• Grafik sembolleri 

• Film klibi sembolleri 

• Düğme sembolleri 

• Dosya ithal etmek 

• Saydamlık 

• Web uyumlu renkler 
 
 
Semboller 
 
 
Sembol, Flash’ta bir kez oluşturduktan sonra belgenizde veya diğer  belgelerde tekrar 
tekrar kullanabildiğiniz grafikler, düğmeler ve movie clip’ler için kullanılan bir terimdir. 
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Semboller birçok animasyonda dosya boyutunu  küçültebilir ve yükleme süresini 
kısaltabilir. Belirli bir sembolü bir projede sayısız kez kullanabilirsiniz, fakat Flash’a bu 
sembolle ilgili veriler bir kez dahil  edilir. 
 
 
Semboller Kitaplık panelinde saklanır. Bir sembolü sahne’nin üzerine sürüklediğinizde,  
Flash orijinal sembolü kitaplıkta bırakarak sembolün bir örneğini oluşturur. Örnek, bir 
sembolün sahne’ye yerleştirilen veya başka bir sembol içinde yuvalanan bir 
kopyasıdır. 
 

Flash’ta üç tip sembol vardır ve bunların her biri kendine özgü avantajlara ve  

kısıtlamalara sahiptir. Kitaplık panelinde bir sembolün yanındaki simgeye  bakarak 

bunun bir  grafik mi  düğme mi   yoksa Film klibi   mi olduğunu  

anlayabilirsiniz. 
 
 
 
Movie Clip Sembolleri  
 

Birçok tasarımcı, Flash’taki her türlü nesne için Film Klibi sembolleri kullanır,  çünkü 

Film Klibi en esnek sembol tipidir. Bir Film Klibi sembolüne filtreler, renk ayarları ve 

karıştırma modları uygulayabilirsiniz. Bir Film Klibi sembolünün her örneğini 

adlandırabilir ve ActionScript’le kontrol edebilirsiniz. 
 

 
Movie Clip Zaman çizelgesi en esnek zaman çizelgeleri’dir. Seslerin ve  etkileşimli 

kontrollerin yanı sıra başka film klibi örneklerini de içerebilirler. Film klibi zaman 

çizelgeleri, düğme sembollerinin zaman çizelgelerin’de bulunan ve rollover durumları 

için kullanılan varsayılan kareleri içermezler, ancak isterseniz ActionScript yardımıyla 

rollove durumlarını oluşturarak bir film klibi sembolünden düğme oluşturmanız 

mümkündür. 
 
 
 
 
 
 
 
 
 
 
 
Button  Sembolleri  
 
Düğme sembollerini kullanarak hızlı bir şekilde standart rollover durumlarına sahip 
etkileşimli düğmeler oluşturabilirsiniz. Film klibi zaman çizelgelerin’den  farklı olarak 
düğme sembollerinin zaman çizelgeleri’nde dört kare bulunur: Yukarı, Üzeri, aşağı ve 
Vuruş. Düğme örneklerini tek tek adlandırabilir ve ActionScript kullanarak kontrol 
edebilirsiniz. Ayrıca bunlara filtreler, karıştırma modları ve renk ayarları da 
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uygulayabilirsiniz. 
 

• Up: varsayılan durumdur. 

• Over: fare imleci üzerine getirildiğinde düğmenin aldığı görünümü belirler. 

• Down: üzerine tıklandığında düğmenin aldığı görünümü belirler. 

• Hit: düğmenin etkin alanını, yani fare tıklamalarına cevap veren alanı tanımlar. 
 
 
Graphic Sembolleri  
 
 
Graphic sembollerini; ana zaman çizelgesi’ne bağlanan sabit, yani animasyon 
uygulamayı düşünmediğiniz resimler için kullanırsınız. 
 
Grafik sembolleri esneklik açısından en zayıf sembollerdir. ActionScript‘i  
desteklemezler ve her ne kadar grafik sembollerine animasyon uygulamanız  mümkün 
olsa da bunları etkileşimli kontroller ve seslerle birlikte kullanamazsınız. Grafik 
sembollerine filtreler ya da karıştırma modları da uygulayamazsınız. 
 

Nesneleri Sembollere Dönüştürmek 
 

Sahne üzerinde bulunan herhangibir nesneyi sembolle dönüştürebilmeniz  

mümkündür. Bunu yapabilmek için iki yol bulunmaktadır. 
 

I.YOL: 
 
 
1. Sahne üzerindeki nesneyi seçin 

2. Convert > Converetto Symbole komutunu seçin.  

3. Karşınız çıkan ekrandan sembol tipini belirlerek sembolle dönüştürme  işlemini 

tamamlayabilirsiniz 

II. YOL 
 
 
1. Sahne üzerindeki nesneyi seçin 

2. Library açınız. Kitaplık açık değilse Ctrl-L tuşu ile açabilirsiniz. Seçmiş 

olduğunuz nesneyi sürekle bırakla Kitaplık üzerine bırakınız. 

3. Karşınız çıkan ekrandan sembol tipini belirlerek sembolle dönüştürme  işlemini 

tamamlayabilirsiniz. 
 

Kitaplıkta oluşturduğunuz sembollerin isimlendirmesinde istediğiniz 

karakterleri(türkçe karakterle ve boşluk) kullanabilirsiniz. Ancak kitaplıkta aynı  isimde 

ancak bir sembol olabilir. 
 
 
Bitmap Resimleri Flash’a Aktarmak 
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Birçok tasarımcı, çalışmaya başlarken bir proje için gereken tüm varlıkları kitaplığa 
aktarır ve daha sonra ihtiyaç duyduğu noktalarda bu varlıkları  Sahne’nin üzerine 
sürükler. 
 
 
Not: Resimleri doğrudan Sahne’ye aktardığınızda Flash bu resimleri kitaplığa  da 
aktarır.  
 
Resim Formatları  
 
Flash JPEG, GIF ve PNG dosyalarını destekler; bunların üçü de Bitmap formatlarıdır. 
Fotoğraflarda olduğu gibi degradeler ve küçük renk değişimleri içeren resimler için 
JPEG  dosyalarını kullanın. Geniş düz renk blokları içerenresimler için GIF dosyalarını 
kullanın. Saydamlık içeren resimler için PNG  dosyalarını (Flash’ta kullanılan doğal bir 
format)  kullanın. PNG dosyalarının boyutu genelde JPEG ve GIF dosyalarına göre çok 
daha büyüktür. 

 
PNG dosyalarını, Kitaplık  paneli aracılığıyla saydamlıklarını koruyacak ve daha  küçük 
dosya boyutuyla PEG dosyaları olarak aktarılacak şekilde ayarlayabilirsiniz. 
 
 
Resimleri Kitaplığa Aktarmak İçin: 

 
1. File> Inport > Inportto Library komutunu seçin. 
2. Makinamızdan herhangibir resmi seçin. 
3. Shift tuşunu basılı tutarak seçin yaparsanız birde fazla resmi aynı anda Flash’a 
aktarabilirsiniz. 
4. Aç [Windows] veya Kitaplığa Aktar [Mac OS] düğmesine tıklayın. 

 
Flash, aktardığınız resim dosyalarını Sahne’ye yerleştirmeden kitaplığa ekleyecektir. 
 
Resimleri Sahne’ye Aktarmak 

 
1. File > Inport > Inportto Stage aktar komutunu seçin. 
2. Makinamızdan herhangibir resmi seçin. 
3. Shift tuşunu basılı tutarak seçin yaparsanız birde fazla resmi aynı anda Flash’a 
aktarabilirsiniz. 

 
Bitmap Resimleri Vektörel Nesnelere Dönüştürmek  
 
Bitmap resimleri vektörel nesnelere dönüştürerek filminizin dosya boyutunu 
küçültebilir ve ayrıca söz konusu grafiği düzenleme konusunda daha fazla esneklik 
sağlayabilirsiniz.Bitmapi izle komutu bir bitmap resmi, düzenlenebilir farklı renk 
alanlarına sahip vektörel bir grafiğe dönüştürür. Dosya boyutunu  küçültmek çok fazla 
detay içermeyen resimleri vektörel nesnelere döndürmek faydalı olucaktır. Ancak 
detay içeren bir resmi vektörel bir içeriğe döndürürseniz bu işlem dosya boyutunun 
daha  üyük olmasını sağlayacaktır. 
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1. Sahne üzerindeki resim nesnesi seçili durumdayken Edit > Bitmap >  Bitmapi 
izle komutunu seçin. 
2. Karşınıza çıkan seçeneklerden Renk eşiği, Minimum alan, Eğim  düzgünlüğü, 
Köşe eşiği değerlerini değiştirerek farklı sonuçlar elde  edebilirsiniz. Vektörel 
nesneler matematiksel ifadelerdir. Burada seçmiş olduğunuz değerler 
doğrultusunda oluşacak matematiksel denklem daha  karmaşık  olabilir  ve  
sonucunda  daha  kaliteli  bir  vektörel  resim  ancak daha büyük boyutta bir öğe 
oluşacaktır. Yine seçimleriniz doğrultusunda daha basit bir denklem oluşabilir. 
Böyle bir durumda 

 
görsel olarak daha az detay içerecek ancak dosya boyutu daha küçük olucaktır. 
Bu değerleri değiştirirek sizlere çeşitli denemeler yapmanızı  ve sonuçları 
gözlemlemenizi öneririm 

 
Film Klibi Sembollerine Bitmap’ler Eklemek  
 
Her sembolün kendi Zaman çizelgesi’ı vardır. Katmanları, tıpkı ana Zaman çizelgesi’a
 eklediğiniz gibi bir sembolün Zaman çizelgesi’ına da 
ekleyebilirsiniz. Siz ilgili varlıkları bir sembolün Zaman çizelgesi’ına eklerken  bunlar 
sembolün içinde yuvalanırlar.   
 
Bu işlem öncesinde kitaplığınızda bir film klibi sembolü olduğunuzdan emin olunuz.   

 
 
 
 
 
 
 
 
 
 
 
 
1. Kitaplıkdaki Film klibi sembolü’nün ikonu üzerine iki kez tıklayınız. Zaman 
çizelgesi’nin olduğu panelde resimdeki gibi Sahne 1 ve bunun  yanında şu anda 
hangi Film klibi’ni değiştiriyorsanız onun kitaplık ismi yer alıcaktır. 

2. Yeni bir katman oluşturun. Yeni bir katman oluşturmak için Zaman çizelgesi’nin 

 altında bulunan yeni katman ikonuna tıklayınız. 

Kullanacağımız her nesne yada sembol için Zaman çizelgesi’nde bir katman 

oluşturmak en pratik ve sonraki değişikler için en akılcı yoldur. Yeni katmanlar 

oluşturduğunuzda bunlara akılcı isimler vermekte  faydalı olucaktır. 
 
 
3. Yeni oluşturduğumuz katmanı seçiniz ve kitaplıktan bir resim 

sembolünü sahnenin üzerine bırakınız. Burada yapılabilecek olası hata  

sembol’ün katman üzerine bırakılmaya çalışılması olucaktır. Doğru olan 

hareket sahne üzerine bırakılmasıdır. 
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Button larla Çalışmak 
 

Üzerine tıkladığınızda, fare imlecini üzerine getirdiğinizde veya başka işlemler  

uyguladığınızda düğmelerin görünümünü değiştiren rollover durumlarına sahip 

etkileşimli düğmeler oluşturmak için düğme sembollerini kullanırsınız. İleri ki 

bölümlerde düğmeleri interaktif bir şekilde kullanmak için daha detaylı bilgiyi 

bulabilirsiniz. 
 

Bir Düğme Sembolü Oluşturmak 
 

Mevcut bir varlığı bir düğme sembolüne dönüştürmeniz mümkündür. Ancak burada 

sizlere bir düğme oluşturulmasını sıfırdan anlatacağım. 
 
 
 
 
 
 
 
 
 
 
1. Ekle > Yeni sembol komutunu seçin. 

2. Sembole dilediğiniz bir ad verebilirsiniz. 

3. Tür alanında Düğme’yi işaretleyin ve TAMAM düğmesine tıklayın. 
 

Düğme Durumları  
 

Up, Down ve Over düğme durumları grafik, renk, şekil veya boyutlarla ilgili her türlü 

değişikliği içerebilir. Eğer düğme durumlarından oluşan karmaşık bir grup yaratmak 

istiyorsanız, resminizi Adobe Photoshop’da hazırlayabilirsiniz. 

 

 
 
 
 
 
 
 
 

 
Düğmelerin dört hali bulunmaktadır. Bunlar sırası ile  

 
 

• Up: Düğmelerin ekranda kullanıcı ile iletişime(kullanıcı tıklamadı  veya düğme 

üzerine gelmedi) geçmedikleri durumudur. 
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• Over: Kullanıcının düğmenin üzerine geldiğinde düğmenin nasıl 

görüneceğinin elirlendiği durumdur. 

 •Down: Kullanıcının düğmeye tıkladığında düğmenin nasıl  görüneceğinin 

belirlendiği durumdur. 
• Hit: Kullanıcının düğme üzerinde hangi Alana tıklayabileceğini belirleyen 
konumdur. Her düğme için ancak bir alan belirlenebilir. Bir alan belirlenmediğinde 
düğme hallerinden en büyük alana sahip olan konum vuruş konumu olarak 
kullanılır.   

 
Sahneye Düğme Ekleme  
 
Zaman çizelgesi’ne dügmeyi 
yerleştireceğiniz katmanı seçtikten sonra 
kitaplıktan eklemek istediğiniz düğmeyi sahneye sürükleyip bırakabilirsiniz. Daha 
öncede belirtiğim gibi sahneye eklenecek her yeni eleman için yeni bir katman 
oluşturmak iş akışınızı kolaylaştıracaktır. 
 
Bir Düğmeye Vuruş Durumu Eklemek  
 
Yukarıda düğmelerin halleri hakkında bilgi verilmiştir.  Ancak bu durumlar, Vuruş 
durumu mevcut değilken hiçbir etkiye sahip olmayacaktır. Vuruş durumu düğmenin 
etkin alanını, yani fare tıklamalarına cevap veren alanı tanımlar. Bu bölümde Vuruş 
durumu için düğme alanını temsil eden bir dikdörtgen çizeceksiniz, ancak bu alan 
filmin en son halinde görünmeyecektir.  Belirli bir sembol için bir Vuruş durumu 
oluşturduğunuzda, Vuruş durumu sembolün her örneğine otomatik olarak uygulanır.   

 
Vuruş  durumunu  tanımlamak  için  bir  dikdörtgen  ya  da  başka  bir  şekil  çizmeniz 
gerekmez. Eğer düğmenin etkin alanının Yukarı, Üzeri ya da Aşağı durumundaki 
grafikle tam olarak eşleşmesini istiyorsanız, Alt [Windows] ya da Option [Mac OS] 
tuşunu basılı tutun ve Zaman çizelgesi’ndeki diğer durumlardan birinde bulunan 
noktayı Vuruş durumunun üzerine sürükleyin. 

 
Görünmez Bir Düğme Oluşturmak  
 
Flash’ta düğmeler düğme gibi görünmek zorunda değildir. Aslında üzerine  görünmez 
bir düğme yerleştirdiğiniz her şey bir düğme gibi davranabilir. 

 
Görünmez bir düğmenin üzerine imleci getirdiğinizde ya da tıkladığınızda  ekrandaki 
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görüntü değişir veya bir eylem  gerçekleşir, fakat kullanılmadıkları  zamanlarda 
düğmeler ekranda gereksiz yere kalabalık yaratmazlar. Görünmez düğmelerin ne 
zaman ve nasıl kullanılacağı tasarıma göre belirlenir. Örneğin türkiye haritasındaki her 
şehir için bir o şehri bir resim Düzenleor ile kesip daha sonra flash’da düğmeler haline 
getirmek yerine, ki bu işlem çok uzun soluklu olacaktır. Gizli düğmeler yaratıp bu 
düğmeleri resim üzerine  yerleştirip kullanıcıların tıklamasına olasılık tanımak daha 
mantıklı ve kolay olacaktır. 

 

1. Insert > New Symbol komutunu seçin. 

2. Sembolü ‘‘görünmez_buton’’ olarak adlandırın. 

3. Tür alanında düğme’yi işaretleyin ve TAMAM düğmesine tıklayın. 

4. ‘‘görünmez_buton’’ Zaman çizelgesi’nde Vuruş karesini seçin. 

5. Insert > Time Line > Blank Key Frame komutunu seçin. 

6. Dikdörtgen aracını kullanarak istediğiniz boyutlarda bir dikdörtgen 

çizin. 
 
 
Artık bu düğmeyi sahnede istediğiniz yerde kullanabilirsiniz. Genel yapılan hatalardan 
biri ise her farklı büyüklükte gereken düğmeler için gizli düğmeler oluşturulmasıdır. 
Unutmayınız ki görünmez bir düğme yaratıp bunu sahneye ekledikten sonra 
istediğiniz gibi farklı farklı boyutlarda kullanabilirsiniz. 

 

Örnek’ler  İle Çalışmak 
 
Flash kitaplığından sahneye bıraktığınız her sembol kitaplıktaki sembolün bir 
yansımasıdır.  Gündelik hayatımızda bir çok yansıma vardır. Örneğin aynaya  
baktığımızda kendi yansımamızı görürüz ve bizimle tıpa tıp aynıdır. Eğer biz kolumuzu 
kaldırırsak aynada da kolumuz havaya kalkar. Flash’daki yansımalar da aynı prensip ile 
çalışırlar. Kitaplık içindeki sembolü değiştirdiğinizde sahne  üzerindeki tüm 
yansımalarıda değişir.  

Alpha Eklemek 
 
 
Flash’ta saydamlık , bir renk ya da sembolün alfa değeri tarafından belirlenir. Alfa 
değerini azalttığınızda opaklık azalır ve saydamlık miktarı artar. Bir sembolün 
kendisinin ya da belirli bir örneğinin alfa değerini değiştirebilirsiniz. 
 
 
Bir Örneğin Alfa Değerini Değiştirmek  
 

Flash’da sembollerin saydamlıklarını kolaylıkla değiştirebilirsiniz.  
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1. Bir dikdörtgen çizelim ve bunu bir grafik sembolüne dönüştürelim.Bunu  

yapabilmek için şeklimizi seçtikten sonra  Modify > Convert to Symbol komutunu 

seçin.  

2. İsimlendirmesini yapıp Kitaplığa eklenmesini sağlayınız. Tür olarak Film klibi , 

düğme yada grafik seçebilirsiniz. Unutmayınız ki kitaplığa ekledikten sonra şu an 

sahnede bir şekil yerine artık bir kitaplık sembolü bulunmaktadır.   

3. Sahne üzerindeki sembol yansımasını seçerek özellikler denetçisindeki Renk  

menüsünden Alpha’yı seçin. 

4. Yüzde alanına değiştiriniz. 
 

Bir Rengin Alpha Değerini Değiştirmek  
 

Sembollerin olduğu gibi renklerinde saydamlıklarını değiştirebilirsiniz.  

Sahne üzerine siyah renkli bir daire çiziniz. 

1. Seçim aracı ile bu çizimi seçiniz ve özellikler denetçisindeki Dolgu rengi  

kutusuna tıklayın. 

2. Alfa değerini değiştirirek saydamlığını değiştirebilirsiniz 
 
 
 
 
 
 
 
 
 
 
 
 

a. Web Uyumlu Renkler Kullanmak 
 

b. 256 renk kullanan bir Web tarayıcısında birçok renk, renk taklidi uygulanmış 
olarak görünür. Flash’ın web uyumlu paleti, farklı işletim sistemleri ve Web 
tarayıcılarının kullanıldığı farklı bilgisayarlarda renk taklidi uygulanmadan  
beklediğinize en yakın şekilde görüntülenen 216 rengi içerir. Web uyumlu  
palet, Flash’taki varsayılan renk paletidir.   

 
 

c. Günümüzdeki bilgisayarların büyük bir kısmı binlerce ya da milyonlarca renk  
görüntüleyebilmektedir, bu da Web uyumlu renklerin eski önemini  yitirmesine 
sebep olmuştur. Bununla birlikte, elde taşınan cihazlar ve cep telefonu 
ekranları daha sınırlı renklere sahiptir; dolayısıyla bu cihazlarda görüntülenecek 
SWF dosyalarını oluştururken Web uyumlu renkleri kullanmak en iyisidir. 
Flash’ta nesnelere renk eklerken Web uyumlu paleti kullandığınızdan emin 
olmak için Renk örnekleri paneli menüsünden Web  216’yı seçin. 
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Bölüm 5 AnimasyonBölüm 5 AnimasyonBölüm 5 AnimasyonBölüm 5 Animasyon    
Bu Bölümde Neler Var? 

• Animasyon ve temelleri 
• Hareket animasyonları 
• Maskeler 
• Şekil animasyonları 
• Saydamlık ile animasyon 
• Bir yol boyunca animasyon 
• Kareler ile çalışmak 
• Animasyonun hızını değiştirmek 

Animasyon 
Animasyon, nesnelerin belirli bir zaman dilimi içerisinde gerçekleşen hareketleri ya da 
değişimleridir. Animasyon, bir kutunun bir kareden diğerine geçilirken Sahne boyunca 
hareket etmesi şeklinde çok basit bir formda olabilir. Çok karmaşık animasyonlar 
hazırlamak da mümkündür.Bir karakterin  birçok farklı özelliğini animasyonla 
birbirinden bağımsız olarak canlandırabilirsiniz: Örneğin kollarını ve bacaklarını, 
gözlerini, kulaklarını veya dilini. Nesneleri hareket ettirebilir, nesnelerin renklerini ya 

da saydamlık özelliklerini, boyutlarını ve hatta şekillerini 
bile değiştirebilirsiniz. Flash’ta  nesnelere animasyon 
uygulamak için Zaman çizelgesi’nde çeşitli anahtar 
kareler oluşturursunuz. Flash, her anahtar karede 
Sahne’nin geçerli durumunu kaydeder: Nesnelerin 
konumunu, rengini, boyutunu, şeklini ve diğer 
özelliklerini. Kademeli olarak ilerleyen bir animasyon 
oluşturmak istiyorsanız, her kare için bir anahtar kare 
oluşturabilir ve bunların her birinde nesnelerde  küçük 

değişiklikler yapabilirsiniz. Bununla birlikte, Flash’ta Hareket arası ve  
Şekil arası oluştur’ların sağladığı avantajları kullanmak işinizi çabuklaştıracak  ve 
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kolaylaştıracaktır: Bu yöntemlerdesiz başlangıç ve bitiş karelerini oluşturursunuz ve ara 
kareleri sizin yerinize Flash hazırlar.Hareket arası  tekniğinde, Sahne üzerindeki 
konumda ve büyüklük, renk ya da diğer özelliklerde gerçekleşen değişiklikler için 
animasyon kareleri oluşturulur. Şekil  arası tekniğinde bir şekli başka bir şekle 
dönüştürmek için animasyon kareleri oluşturulur. Örneğin kare şeklinin daire şekline 
animasyonla döndürülmesi  gibi. Bu değişikliği, nesnenin farklı özelliklerini ayarlayarak 
gerçekleştirmek mümkün değildir; animasyonda başlangıçtaki nesne ile sonuçta elde 
edilen nesne tamamen farklıdır. Şekil araları bir şekli başka bir şekle dönüştürürken 
bu dönüşümün düzgün bir şekilde görünmesini sağlar. Flash ayrıca, düz bir yol 
üzerinde gerçekleşen hareketlere göre çok daha karmaşık olan hareketleri  
animasyonla hızlı bir şekilde gerçekleştirmenizi sağlayan bir yöntem sunar.İstediğiniz 
kadar karmaşık bir yola sahip bir hareket kılavuzu  oluşturabilir, daha sonra nesnenizi 
bu kılavuza bağlayabilir ve hareket arası  uygulayabilirsiniz. Flash, animasyon 
karelerinde ilerlerken nesnenin yolun üzerinde kalmasını sağlar. 
 
 
 

 

Time Line Panelinin Temelleri: 
 
 
 
 
Hareket Animasyonları 
 
 
Bir Film Klibi Sembolüne Animasyon Uygulamak  
 
Film klibi sembollerinin kendi Zaman çizelge’leri vardır, böylece animasyon 
oluşturmak için büyük esneklik sağlarlar. Film klibi sembollerini birbirlerinin içinde 
yuvalamanız da mümkündür.  

 
 
 
Sembolleri Düzenlemek Ve Animasyon  
 
Bir sembolü düzenlemek istiyorsanız, Sahne’de ya da Kitaplık panelinde bu  sembole 
çift tıklayın. Sahne’nin üzerindeki bir sembole çift tıkladığınızda bu sembolü yerinde 
düzenleyebilirsiniz; bu durumda Flash Sahne’deki diğer nesneleri soluklaştırır, fakat bu 
nesneler yine görünür durumda kalır. Kitaplık panelindeki bir sembole çift 
tıkladığınızda, düzenleme işlemi sırasında sadece  bu sembol görünür. 
 
Bir Film klibi sembolünü düzenlerken bu sembolün Zaman çizelgesi’ne  katmanlar ve 
anahtar kareler ekleyebilirsiniz. Aslında bir film klibi sembolünün Zaman 
çizelgesi’inde, ana Zaman çizelgesi’nde yapabildiğiniz hemen her türlü işlemi 
yapabilirsiniz. 

 
1. Sahne üzerine bir daire çizin ve bu daireyi kitaplığınızı bir Film klibi olarak atın 
2. Çalışma alanındaki daire artık bir çizim değil bir Film klibi’dir. Bu daireyi seçip 
özellikler denetleyicisinden x ve y konumlarını sıra ile 100 ve 100 olarak giriniz. 
3. Katman 1’deki 50 numaralı kareyi seçin. Bu karenin şu an varlığı 
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bulunmamaktadır ve şu an için animasyonumuz sadece bir kareden oluşmaktadır. 
50 numaralı kare seçilirken yapılabilecek en yaygın hata bunun Zaman çizelgesi 
üzerindeki kadran üzerinde seçilmesi olucaktır. 50 nolu kareyi seçebilmek için 50 
rakamı ile ‘‘katman 1’’ katmanının kesistiği yere tıklayın  4. F6 tuşuna basarak 
burada bir anahtar kare oluşturun. Şu an ‘‘katman 1’’  katmanında iki adet içi dolu 
siyah nokta görüyor olmalısınız. Bu sizin şu an iki tane ana kareye sahip 
olduğunuzu göstermektedir. 
5. Sırasıyla 50 nolu kareye tıklayıp daha sonrada sahnede bulunan dairemizin 
üstüne tıklayarak dairemizi seçelim. Özellikler denetçisinde X alanına 300 ve Y 
alanına 100 değerini girin.   
6. Animasyon yapabilmek için minimum gerekli olan iki ana karemiz artık var. Bir 
animasyon yapabilmek için en önemli kural aynı katmanda en az iki adet anahtar 
karenin bulunmasıdır.  
7. 1.kare ile 50.kare arasında herhangi bir kareyi ve ardından Özellikler 
denetçisindeki Arayı doldur menüsünden Hareket’i seçin. 

 
 
 

Böylece ilk Hareket arası animasyonuzu oluşturdunuz: 
Animasyonuz bir  daire  ekranın solundan sağına doğru 
hareket etmektedir. Şimdi animasyonu test  etmek ve 

izlemek için Kontrol Et >Filmi Test Et komutunu çalıştıralım. 
 
Eğer animasyonuzda değişiklik yapmak istiyorsanız bunları ilk kareyi(1nolu ana kare) 
yada son kareyi(50 nolu ana kare) seçip dairenizi farklı konumlara taşıyabilir yada 
büyüklüklerini değiştirebilirsiniz. 
 
 
Not:Hareket arası yapabilmeniz 
animasyonda kullanacağınız nesne mutlaka 
kitaplik elemanı(sembol) olmalıdır. 
 
Animasyonlu Bir Sembolü Çoğaltmak  
 

Yukarıdaki örnekte animasyonu gerçekleştirdiğimiz yer ana sahne yani ‘‘Sahne  

1’’ idi. Ancak tasarım dünyasında bizler daha çok animasyonlarımızı başka sembollerin 

içerisinde yapmayı ve bu sembolleri de istediğimiz yerde istediğimiz kadar kullanmayı 

tercih ediriz. Biraz önce yapmış olduğunuz bu animasyondan sahnede 5 tane daha  

yapmak yerine bu animasyonu keşke bir kere yapıp daha sonra istediğimiz kadar 

kullanabilecek olsak ne güzel olurdu. 
 
 
Burada yardımızı işte Film klip’leri gelmekte. Film klip’leri içerisinde  animasyon 
barındıra bilen tek sembol türüdür. Eğer bir animasyon yapıp bunuda kitaplığımızda 
saklamak istiyorsak kullanmamız gereken sembol tipi Film klibi olucaktır. Kitaplıkta 
saklamak istediğimiz bir çizim ve animasyon içeremeyecekse tip olarak grafik 
seçilmelidir. Ancak bu tür nesneler içinde Film klibi seçilmesi animasyonunuz 
açısından bir sıkıntı oluşturmaz.   
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Şimdi Animasyonlu Bir Sembol Oluşturacağız  
 
1. Sahne üzerine bir daire çizelim ve bunu kitaplığımıza bir grafik sembolü olarak 
‘‘top’’ ismi ile ekleyelim. Bu sembol Film klibi içerisinde hareket  ettireceğimiz 
semboldür.  Bildiğiniz gibi Hareket arası yapabilmemiz  için gerekli olanlar 2 tane 
ana kare ve hareket edecek semboldür. 
 
 
 
 
 
 
 

2. Bir Film klibi’ne ihtiyacımız var. Şimdiye kadar dikkat ettiyseniz hep bir çizim yaptık ve 
daha sonra bu çizimleri kitaplık elemanı(sembol) haline dönüştürdük. Yani hep bir şeyi 
bir başka şeye çevirdik. Ancak bazı  durumlarda boş bir sembol de yaratıp daha sonra 
içeriğini eklememiz gerekebilir. Bunu yapmak için kitaplığın sol alt köşesinde bulunan( 
)  

 
 
 
 

artı işaretine tıklayabilir yada Ekle>Yeni sembol ekle seçeneğini kullanabiliriz. 

Bu işlem sonrasında Flash bizim için istediğimiz türde boş bir sembol 

oluşturacaktır. 

3. Sembolümüzü Film klibi olarak belirleyip ismini ‘‘topanimasyon’’ diyelim. Şu an 

Zaman çizelgesi’nin altına baktığınızda aşağıdaki gibi bir resim görmelisiniz. 

Bunun anlamı şu an bizi ‘‘topanimasyon’’ adındaki  

4. Film klibi içerisinde değişiklik yapıyoruz. 
 

 
4. Sahne 1’in ilk karesine kitaplığımızda bulunun ‘‘top’’ isimli grafik sembolünü 
yerleştirelim. 50.kareye gidip F6 kısa yolu ile bir ana kare oluşturalım ve bu karede 
sahnede bulunan nesnemizi seçip konumunu değiştirelim. Şu an hem 1.kare 
hemde 50.karede top isimli sembollerimiz bulunmaktadır. 1. ve 50. Kare 
arasındaki her hangibir kareyi seçelim ve özellikler denetleyicisinin arayı doldur 
kısmından ‘‘hareket’’ diyerek animasyonu tanımlıyalım  
5. Bu aşamada filmi Kontrol Et>Filmi Test Et yada CTRL-Enter ile test  ederseniz  
Bunun sebebi oluşturulmuş olduğumuz Film klibi şu an sadece kitaplıktadır. 
Film klibi’nin sahneye yerleştirilmesi gerekmektedir. Şu an Zaman 
çizelgesi’nin altına bakarsanız ‘‘topanimasyon’’ adından bir Film klibi içinde 
oldugunu görecekseksiniz. Öncelikle ana sahnemize dönüp sembolü 
yerkeştirmemiz gerekmektedir. Aşağıdaki resimdeki gibi ‘‘Sahne1’’ ikonuna 
tıklayarak ana sahneye dönüyoruz. ‘‘Katman 1’’ içerisinde şu an top sembölü 
bulunmaktadır.  Bu nesneyi sahnedeseçelim ve  lavyemizden delete tuşunun 
yardımı ile silelim. 
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6. Şimdi ‘‘topanimasyon’’ adındaki Film klibi dosyamızı
 sahneye  yerleştirmeye geldi. Kitaplıktan ‘‘topanimasyon’’ sembolünü seçelim 

ve ‘‘Katman1’’ in birinci karesine sürükleyip 
bırakın. Filmi test edin  
7. Aynı sembolu bir kaç kullanabilir ve 
hareket eden top animasyonunun sahnede birden 
fazla kere gösterilmesini sağlayabiliriz. Bunun için  
istediğiniz kadar katman yaratın ve yaratılan her 
bir katmanın anahtar karelerine kitaplıktan 

‘‘topanimasyon’’ Film klibi sembolünü yerleştiriniz. Konumlarını değiştirin ve filmi 
test ediniz. 
8. Kullandığımız her Film klibi aynı animasyonu
 yapmaktadır. Kitaplığımızdaki Film klibi’ni değiştirirsek sahne  

 
 
 
 
 
 
 
 
 
üzerindeki kullandığımız tüm yansımaları otomatik olarak değişecektir ve 
animasyon yeni bir görünüm kazanacaktır. Ancak bu noktada dikkat edilmesi 
gereken öenmli bir nokta vardır. Örneğin ekranda soldan saha doğru giden bir 
animasyonumuz var ve bu animasyon bir Film klibi içerisinde tasarlanıp sahneye 
yerleştirilmiş.  Aynı zamanda yukarı  aşağıya giden bir animasyona ihtiyazımız var 
ise bu animasyonu yeniden tasarlamak yerine aynı Film klibi’ni kullanıp dönüştür 
panelinin yardımı döndürüp yukarı aşağıya gitmesini sağlayabiliriz. Yani sahne 
üzerine yerleştirilmiş sembollerin renk, boyut, konum ve açılarını  sembollere 
değiştirmeden kullanabilmekteyiz. Bu animasyon yaparken iş akışımızda büyük 
kolaylık sağlamaktadır. Bu örneğimizde bir grafik  sembolünü bir Film klibi 
sembolü içerisine yerleştirdik. Aynı şekilde bir Film klibi’ni bir Film klibi’nin 
içerisine onuda başka bir Film klibi içerisine koyabilirsiniz. 

 
 
 
Not:  Bir sembol başka semboller içerebilir; aslında sembolleri başka sembollerin 
içinde, bu sembolleri de daha başka sembollerin içinde, yani birkaç katman
 derinde olacak şekilde yuvalayabilirsiniz. Karmaşık animasyonlar 
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oluşturmak üzere, yuvalanmış her sembole ayrı olarak animasyon uygulamanız 
mümkündür. 
 
Sembollere Maskelerle Animasyon Uygulamak 
 
Maskeler Flash animasyonlarında kullanılan yaygın tekniklerden biridir. Maskeler bir 
katmandaki animasyonun kullanıcı tarafından görünebilecek alanının belirlenmesine 
yarar. Maskeler istediğiniz şekilde olabilir ve sahne  üzerinde kapladıkları alan 
önemlidir. Renk özelliği maskeler için etkisiz bir özelliktir. Yani maskelerin renklerinin 
değiştirilmesi animasyonunuzda bir değişiklik yaratmaz. Bunlarla beraber maskeler 
durağan olmak zorunda değildir ve animasyonda içerebilirler.   

 
 
 

 
 
 

Bir maske animasyonu yapmamız 

gerektiğinde iki adet katmana ihtiyaç  

duyarız. Bunlardan ilki

 maske uygulanacak katman

 , genellikle 

animasyonumuzu içeren katmandır. İkincisi ise bu animasyona uygulamak istediğimiz 

maskeyi içerecek maske katmanıdır. 
 
Maskelenecek Katmanları Hazırlamak  

 
1. Sahne üzerine bir daire çizelim ve bu daireyi ‘‘top’’ ismi ilen kitaplığımıza grafik 
sembolü olarak ekleyelim. 
2. Sembolün bulunduğu katmanda animasyon yapıcağız. Bunun için ikinci bir 
anahtar kareye ihtiyaç duymaktayız. 50.kareye gidelim ve F6 kısa yolunu 
kullanarak yada 50.kareyi seçtikten sonra sağ düğme ile ‘‘Kare Ekle’’ seçeneği ile bir 
ana kare oluşturalım. 
 
 
 
 
 
 
 
 
 
 

 
3. 50.kareyi seçelim ve daha sonra sahne üzerindeki top isimli sembolümüzü 
seçelim. Dönüştür penceresi ile sembolü %300 oranında büyütelim. 
4. Sembolü içeren katmanın 1. ve 50.karesi arasındaki herhangibir kareyi seçip  
özellikler denetleyicisinden Arayı doldur kısmından ‘‘hareket’’ seçeneğini seçerek 
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animasyonu yaratalım.Filmi test edin ve animasyonun çalıştığından emin 
olunuz. 

 
 
 
 
 
 
 
 
 
 

Maskeyi Oluşturmak Maskeyi Oluşturmak Maskeyi Oluşturmak Maskeyi Oluşturmak     
 
1. Artık animasyonuzu maskeleyeceğiz. Bunun için maskeleyecek yani  maske 
öğesini taşıyacak bir katmana ihtiyacımız var. Top sembolünün bulunduğu 
katmanı seçelim ve ‘‘Katman ekle’’ ikonuna tıklayarak yeni katman oluşturalım. Bu 
katmanda maskemizi oluşturacağız. 
2. Yeni katmanı seçin ve sahneye dolgusu olan bir kare çiziniz. Eğer çizmiş 
olduğunuz katman konum olarak dairenin üzerinede değil , yukarısında  
,aşağısında yada yanında ise seçim aracını seçelim ve karenin üzerine iki kez 
tıklayarak karenin hem dolgusunun hemde konturun seçilmesini  sağlayalım. Artık 
kareyi taşıyabilirsiniz. Kareyi dairenin üzerine gelecek şekilde konumlandırın. 
3. Maske katmanında kare yerine bir üçgen kullanmak istiyoruz. Ancak dikkat 
ettiyseniz Flash içerisinde özel bir üçgen aracı bulunmamaktadır. Üçgen çizmek 
için dikdörgen aracı ile aynı yuvada konumlanmış "Çokgen yıldız" aracını kullabilir 
yada şimdi anlatacağım tekniği kullanabilirsiniz. Öncelikle kare nesnemizin
 seçili olmaması gerekmektedir. Bunun için eğer kare seçili ise sahnede , seçim 
aracı ile sahne üzerindeki herhangibir boş alana bir kez tıklayalım. Bu karenin 
seçimden çıkarılmasını sağlayacaktır. Daha sonra karenin sol üst  köşesine doğru 
seçim aracımız ile yaklaşalım. Tam köşe noktasına yaklaştığımızda fare imlecinin 
bir köşe şeklini anlatır şekilde değiştiğini göreceksiniz.  İmlecimiz bu şekilde iken 
sol üst köşeyi sürükle bırak ile sağa doğru taşıyalım ve kenarın tam ortasına 
geldiğimizde bırakalım. Shift tuşunun yardımı ile doğrusal bir şekilde tasıma 
yapabilirsiniz. Aynı işlemi sağ üst köşe içinde yapalım ve bu sefer sola doğru 
sürükleyip bir önceki bıraktığımız konum  le yanı konumda bırakalım. Karemizi şu 
an bir üçgene döndürdük. 

 
 
 

 
 
 

4. Maske animasyonumuzu yapmak için Flash'a artık bu katmanının bir maske 
katmanı olduğunu belirmemiz gerekmektedir. Katmanın isminin üzerinden sağ 
düğmeye tıklayın  e açılan menüden "Maske" seçeneğini seçiniz. 
5. Animasyonu test edin. Animasyon bir üçgen içersinde büyüyüp küçülen bir 
daire şeklinde görünecektir. Bu animasyonda bir daireyi bir üçgen ile maskeledik 
ve animasyonun görünebilir alanlanı belirledik 
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Not:   

 
1. Bazen animasyonunuz gereği bir maskeyi bir çok katman üzerinde kullanmak 
isteyebilirsiniz. Bu tür durumlarda her katman için ayrı ayrı aynı şekilde bir maske 
katmanını oluşturmak yerine bir maske katmanına bir çok katmanı 
bağlayabilirsiniz. Bunu yapabilemek için maske katmanınızı yaratın ve bu maske 
katmanına bağlamak istediğiniz diğer katmanları sürükle bırak ile bu maske 
katmanının alt sağına doğru  taşıyın. Eğer bu noktada sıkıntı yaşıyorsanız taşıma 
işleminde görsel  olarak yuvalanmayı izlemleyebilir ve tam bu noktamada 
sürükleme işlemini sonlandırabilirsiniz. 
2. Maske katmanları başla maske katmanları ile yuvalanamazlar. 

 
 
 
Hareketli Maskeler Oluşturmak 

 
1. Katman1 katmanına bir resim ihtal edin. 
2. Yeni bir katman oluşturun ve bu katman içerisine bir daire çizin ve bu daire’yi 
kitaplığınıza bir grafik sembolü olarak ekleyin. 
3. Daire’nin bulunduğu katmanın 50.karesinde yeni bir ana kare oluşturun ve bu 
karedeki daire’yi ekranda yeniden konumlandırın.   
4. Daire’nin bulunduğu katmanın  1.Kare ve 50.Kare arasındaki herhangibir 
karesine tıklayın ve özellikler denetleyicisinden arayı doldur kısmından ‘‘hareket ’’ 
seçeneğini seçerek animasyonu oluşturun. 
5. Zaman çizelgesi üzerinde şuan iki adet katmanımız bulunmaktadır. Bunlardan 
animasyon içeren katman 50 kare uzunlunluğunda , resim içeren katman ise 1 kare 
uzunluğundadır. Maskemizin tüm flash filmi boyunca resmimizi maskeleyebilmesi 
için resim bulunan katmını 50 kare boyunca uzatmalıyız. Bunu yapmak için bu 
katmanın 50.karesine tıklayalım ve F5 kısa yolu yada sağ düğme ile ‘‘Kare ekle’’ 
seçeneğini  seçiniz 
6. Animasyonu test ediniz. 

 
 
 
Şekil Animasyonları: 
 
Şekil arası tekniği, bir nesneyi, kendisinden çok farklı olan başka bir nesneye  bile 
düzgün bir şekilde dönüştürmenizi sağlar. Örneğin bir dairenin dikdörtgen şekline 
dönüştrülmesi ancak şekil arası ile yapılabilmektedir. 

 
Not:   

 
 
1. Gruplara, örneklere ya da bitmap resimlere şekil arası uygulamak için önce ilgili 
öğeleri parçalayarak birbirinden ayırmanız gerekir. 

2. Şekil arası sadece şekillere uygulanabilir, semboller üzerinde şekil arası 

yapılamaz. 
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Bir Şekil Animasyonu Oluşturmak 

 
1. Animasyonu oluşturacağımız katmanı seçelim ve bu katmanın ilk karesine bir 
daire çizin. 
2. Animasyonun son karesini oluşturmak için 50.kareyi katman üzerinden seçin, 
sağ düğme ile açılan menüden ‘‘Boş ana kare ekle’’ komutunu uygulayın. Daha 
önce yapmış olduğunuz hareket animasyonlarında hatırlayabileceğiniz gibi 
genellikle ana kare kullanıyorduk. Bu örnekte ise boş bir ana kare oluşturduk. Şekil 
animasyonları şekil değişiklikleri  için kullanılır ve yeni bir ana karenin katmana 
eklenmesinde bir  nceki ana karenin içeriği yeni ana kareye otomatik olarak 
kopyalanır. Biz bu  içeriği silip yerine yeni bir çizim yapmak yerine oluşturup 
bunların içine çizim yapmayı tercih ederiz. 
3 Yeni oluşturmuş olduğunuz boş ana kareye bir kare çizin.  
4. Filmi test edin. Animasyonda bir dairenin bir kareye dönüştüğünü  

göreceksiniz. 

 
 
 
Not:  Metin elemanlarının şekillere dönüştürülmesinde ‘‘Değiştir>Parçala’’ iki kez 

yapılmalıdır. Birinci uygulanışta metin , metini oluşturan harflere ayrılacak.  İkinci 

uygulamada ise her harf bir şekile dönüştürülecektir. 
 
 
 

Nesnelerin Ekranda Yavaşça Belirlenmesini Sağlamak 
 

Gerek hareket gerek şekil animasyonlarında , animasyonlarızın başlangıç yada bitiş 

konumındaki saydamlıklarını değiştirebilirsiniz. 
 
 
1. Bir hareket animasyonu oluşturun. 

2. Animasyonun son ana karesini seçip daha sonra bu karedeki içeriği  sahne 

üzerinden seçiniz. 
3. Property denetleyicisinden color özelliğini ‘‘Alfa’’ olarak seçin ve  değerini %50 
yapın. 
4. Filmi test edin. Animasyonda nesnenin animasyonunun sonuna doğru 
saydamlığının azaldığını izlenleyebilirsiniz. 

 
Bir Yol Boyunca Animasyon Yapmak 
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Flash’da bir animasyon yaptığınızda eğer bir yol kullanmazsanız Flash ilk kare  ile son 
kare arasındaki mesafeyi en kısa yoldan tamamlamaya calışacaktır. Bazı durumlarda 
istenilen durum bu olmaya bilir. 
 
Bir nesneye belirli bir yol üzerinde animasyon uygulamak için önce bir hareket  
kılavuzu oluşturursunuz; Flash, kılavuz için ayrı bir katman oluşturur. Ardından 
Sahne’de kılavuzu çizersiniz. Son olarak nesneyi kılavuzla hizalarsınız 

 
Hareket Kılavuzlu  Animasyon Oluşturmak  
 

Bir hareket kılavuzu kullanarak belirli 
bir nesnenin Sahne’in üzerinde  
izleyebileceği hemen her türlü yolu 
çizebilirsiniz 

 
1. Bir hareket animasyonu 
oluşturun. Animasyonda nesnenizin 
konum değiştirmesi gerekmektedir. 
2. Animasyon içerek katman 
seçili iken Zaman çizelgesi’nin altında 
bulunan ‘‘Add Motion Guide’’ 

seçeneğine tıklayarak bir hareket kılavuzu katmanı oluşturunuz.  
 
 
 
3. Bu katmana nesnemizin takip etmesi gereken yolu çizeceğiniz. Yolu  çizerken 
Kurşun kalem aracını kullanabilirsiniz. Ayrı Flash bir çizimin  konturları varda bu 
konturlarıda kılavuz olarak kullanabilir.  
4. Kılavuzu çizdikten sonra animasyonun ilk ve son karesindeki nesnenin  
merkezinin bu kılavuzun üzerine yerleştirilmesi gerekmektedir. Bu işlem için 
animasyon katmanının ilk karesinindeki nesneyi seçin ve seçim aracı ile 
merkezinden tutup bu çizginin üzerine taşıyın. Nesnenin merkezi kılavuzun 
üzerine oturduğunda nesnenin merkezinde görünen yardımcı daire imleci ddaha 
büyük bir hale gelicektir. Yardımcı imleç bu haldeyken nesneyi bırakıınız. Eğer 
kılavuz üzerine nesneyi oturtmakta  orlanıyorsanız View > Snapping
 > Pixsels yapı ve View>Snapping>Objects yapış seçeneğinin seçili olup 
olmadığını kontrol ediniz. 
5. Aynı işlemi son karedeki nesne içinde tekrarlayınız.  
6. Filmi test edin 

 
Not: Animasyonlarde eğer birden fazla animasyon aynı kılavuzu kullanacaksa 
yeniden bir kılavuz çizilmesi gerekmez. Bir kılavuzu birden fazla katman 
kılavuz olarak kullanabilir. Bunu yapabilmek için katmanları sürükle bırakla 
kılavuz katmanları ile ilişkilendirmeniz yeterli olucaktır. 

 
 

Kareler İle Çalışmak 
 



Balıkesir Özel Serper Bilgisayar Kursu – Ders Notları  
             

Balıkesir Özel Serper Bilgisayar Kursu 
Adres: Hacıilbey Mah. M.A.Ersoy Cad. No:7 Balıkesir 
Tel: (266) 249 97 91 – Web: www.serperbilgisayar.com 

29 

Karelerin Kopyalanması Ve Yapıştırılması  
 

1. Kareyi seçin. 

2. Edit>Time Line>Copy Motion seçeneği ile kareleri  hafızaya alın 

3. Yapıştırmak istediğiniz kareyi seçin. Eğer kopyaladığınız kareler birde fazla ise 

yapıştırmak istediğiniz katman karelerinden ilk kareyi seçin. 
4. Edit>Time Line>Paste Motion ile yapıştırın. 

 
Karelerin Taşınması  

 
1. Taşımak istediğini karelerin üzerinde sürükle bırak ile bir alan oluşturunuz ve 
farenin tuşunu bırakın. Daha sonra seçmiş olduğunuz bu kareleri sürükle bırak ile 
istediğiniz yere taşıyın 

 
 
 
 
 
 
 
 
 
 
Kare Eklemek  

 

• Ana kare eklemek için F6 tuşu yada sağ button ‘‘Insert Key Frame’’ kullanılır 

• Kare eklemek için F5 tuşu yada sağ buton ‘‘Insert Frame’’ kullanılır. 
 

Kare Silmek  
 

• Silmek istediğiniz kereyi seçin ve sağ buton ‘‘Remove Frame’’ seçeneğini  seçin. 

                     Bir kareyi silmek yerine içeriğini silmek istiyorsanız sağ buton ‘‘Clera Frame’’  

 
 
Karelere Etiket Atamak  

 
Karelere rakam yerine daha sonra actionScript ile ulaşmak istiyorsanız karelere  
etiketler verebilirsiniz.  Bunu yapmak için anahtar kareyi seçin ve özellikler 
denetleyicisinde bulunan benimKarem kısmına bir değer atayın.   
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Not:  İsimlendirme yaparken Türkçe karaker, rezerve edilmiş  elimeler(komut  isimleri), 
boşluk kullanmayın ve rakam ile başlamayın. 
 
 
Animasyonun Hızını Değiştirmek 
 
Animasyonunuzu yaptınız ancak animasyonu biraz daha hızlandırmak  istiyorsunuz.   

• Dökümanın kare hızını değiştirebilirsiniz.   
Dikkat: Tercih edilmemelidir. Bu işlem sonucunda döküman  çindeki 
tüm animasyonlar hızlanır ve kitabın başında anlatılan sorunlar le karşı karşıya 
kalınabilinir. 

• Animasyonu oluşturan iki anahtar kare arasındaki mesafeyi abilirsiniz. 
 


